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Introduction
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End User License Agreement

This is a legal agreement between you, the end user, and Gaumard® Scientific Company, Inc.
(“Gaumard”). This software is protected by copyright laws and remains the sole property of
Gaumard. By installing the UNI (the "Software") media, you agree to be bound by the terms of this
agreement. If you do not agree to the terms of this agreement, promptly return the uninstalled
media and accompanying items to Gaumard at the address indicated below.

1. Grant of License. Gaumard hereby grants to you (an individual or institution) the right to install
and activate the Software on one computer for use with one Interactive patient simulator system.
The software may also be installed on any number of other computers at the same institution so
that students may access the learning resources. One copy of the software may be made for
backup purposes. You may not network this Software, or allow multiple users unless you
purchased a multi-user workstation license. Sharing this Software with other individuals or allowing
other individuals to view the contents of this Software is in violation of this license.

2. Copyright. The Software is owned by Gaumard and protected by United States copyright laws
and international treaty provisions. Therefore, you must treat this Software like any other
copyrighted material. You may not make this Software or copies thereof available in any manner or
form or use, copy or transfer the Software, in whole or in part, except as provided herein.

3. Other Restrictions. You may not rent or lease this Software to any other party. You may not alter,
merge, modify, adapt, reverse engineer, decompile or disassemble the software, or disclose the
contents of this Software to any other party.

4. Electronic Transmission of Software. If you received the Software by electronic transmission or
by Internet delivery, by installation of the Software, you acknowledge that you have read and
understand this license agreement and agree to be bound by its terms and conditions.

5. Term of Agreement. The term of this Agreement and the license granted to you pursuant hereto
shall commence upon installation of this Software. This Agreement and the license granted herein
may otherwise be terminated by Gaumard in the event that you are in breach of any provision of
this Agree-ment. In the event of termination, you agree to immediately return this Software,
accompanying items, and any copies thereof to Gaumard.

6. LIMITED WARRANTY

(A) THE CD-ROM MEDIA (THE "MEDIA") WHICH CONTAINS THIS SOFTWARE IS
WARRANTED, FOR A PERIOD OF 30 DAYS FROM THE DATE OF PURCHASE, TO BE FREE
FROM DEFECTS IN MATERIAL AND WORKMANSHIP. ELECTRONIC TRANSMISSION IS
WARRANTED TO BE FREE FROM DEFECTS AT THE MOMENT OF TRANSMISSION. YOUR
SOLE AND EXCLUSIVE REMEDY, AND GAUMARD'S SOLE LIABILITY, IS TO REPLACE THE
DEFECTIVE MEDIA OR TO REPEAT THE ELECTRONIC TRANSMISSION PROVIDED THAT
YOU NOTIFY GAUMARD IN WRITING OF SUCH DEFECT OR DEFECTIVE TRANSMISSION
AND RETURN THE DEFECTIVE MEDIA, IF ANY, DURING THE 30-DAY WARRANTY PERIOD.

(B) EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED IN PARAGRAPH (A), THE
SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED ON AN "AS IS"
BASIS, WITHOUT ANY WARRANTIES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO, ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
PURPOSE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY GAUMARD, ITS
DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN
ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY
SUCH INFORMATION OR ADVICE. GAUMARD DOES NOT WARRANT, GUARANTEE, OR
MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF USE, OF THE
SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY,
RELIABILITY, CURRENTNESS, OR OTHERWISE, AND THE ENTIRE RISK AS TO THE
RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE
SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU AND NOT GAUMARD OR ITS
DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL
NECESSARY SERVICING, REPAIR OR CORRECTION OTHER THAN EXPRESSLY
DESCRIBED ABOVE.
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(C) NEITHER GAUMARD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION,
PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT,
INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS
OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION,
AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT OR
RELATED TO THIS AGREEMENT EVEN IF GAUMARD HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. GAUMARD SHALL NOT BE LIABLE TO YOU FOR ANY
INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOST PROFITS
ARISING OUT OF OR RELATED TO THIS AGREEMENT OR YOUR USE OF THE SOFTWARE
AND/OR THE RELATED DOCUMENTATION, EVEN IF GAUMARD HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL GAUMARD'S LIABILITY HERE
UNDER, IF ANY, EXCEED THE PURCHASE PRICE PAID BY YOU FOR THE SOFTWARE.

ALL RIGHTS NOT EXPRESSLY GRANTED IN THIS LICENSE AGREEMENT ARE RESERVED
BY GAUMARD.

ACKNOWLEDGMENT

BY INSTALLATION OF THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ AND
UNDERSTAND THE FOREGOING AND THAT YOU AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND
EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL
PROPOSED OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE LICENSE DESCRIBED
HEREIN.
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General Care,
Maintenance, and
Warnings

The Gaumard warranty does not cover
damage caused by misuse. It is critical to
understand and comply with the following
guidelines to prevent injury to the user and
damage to the simulator.

Do not use universal AC adapters. Use the
AC adapter specific to the simulator model
supplied by Gaumard only.

If the simulator will not be in use for an
extended period, re-charge the battery at
least once every 30 days to prevent damage
to the battery.

Do not disassemble or attempt to repair the
simulator. Doing so will void the warranty.
Please contact Gaumard technical support
for repair information.

Store the simulator in a cool, dry place.
Extended storage above 85 degrees
Fahrenheit (29 Celsius) will cause the
simulator to soften and slowly warp. It is
acceptable to operate the simulator at an
ambient temperature of 95 degrees
Fahrenheit (35 Celsius).

There are inherent dangers in the use of
some medical devices. For simulations that
incorporate the use of real medical devices,
always know your equipment and follow the
device safety guidelines.

The simulator’s operating limits are
consistent with that of a real human. Treating
the simulator in a manner that would
seriously harm a real person is likely to result
in damage to the simulator. Always treat the
simulator as a real person.

The simulator should never be used to test
the performance or accuracy of a real
medical device.

Do not intubate without lubricating the airway
adjunct with silicone oil lubricant (provided).
Failure to do so will make intubation very
difficult and is likely to result in damage.

Providers must use an empty syringe when
simulating drug administration via
endotracheal tube. Passing liquids into the
trachea or esophagus may cause internal
damage.
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Mouth to mouth resuscitation without a
barrier device is not recommended, as it will
contaminate the airway. Treat the simulator
with the same precautions that would be
used with a real patient.

Do not introduce liquids, humidified gases or
administer aerosol medications into the
airway. Moisture in the airway will damage
the simulator’s internal mechanics.

LATEX WARNING

Vein tubes contain latex, which may
cause allergic reactions. Users allergic or
sensitive to latex should avoid contact.
Discontinue use of this product and seek
medical attention if an allergic reaction
occurs.

Only use the simulated blood solution
provided by Gaumard. Any other simulated
blood containing sugar or additives may
cause blockage and/or interruption of the
vasculature system.

The use of needles larger than 22 gauge will
reduce the lifetime of the lower arms' skin
and veins.

The simulator must be powered on when
working with the Drug Recognition arm. This
includes calibration, purging, draining, IV
infusion, Set Med Id, and injecting fluids.
Failure to do so will permanently damage the
simulator and void the warranty.

Avoid injecting fluids into the intramuscular
sites.

While the simulator is on, purge the IV
system with clean water at the end of every
simulation session. If the drug recognition
arm is not going to be used for a week or
more, purge the system with 70% isopropyl
alcohol solution. Failure to do so may
damage the IV vasculature and permanently
damage the system.

Do not store the simulator with fluid in the
internal reservoirs. Always purge, clean, and
dry the interval fluid reservoirs at the end of
simulation to prevent clogs and molding.

When the arm veins require replacement,
contact Gaumard to arrange for a lower arm
exchange. For a small fee, Gaumard will
deliver reconditioned and warrantied lower
arm assemblies to your facility. After
receiving the replacement arms, use the
same box and the enclosed shipping label to
return the old arms to Gaumard. Refer to the
Consumables and Replacement Parts
section of this guide, and contact customer
service for more information.



Clean the simulator using a damp cloth with
diluted liquid dishwashing soap. If medical
adhesives remain on the skin, clean with
alcohol wipes.

Do not use citric-based cleaners, as the citric
acid in the formula will cause pitting of the
various materials comprising your simulator.

The simulator is "splash-proof" but not
waterproof. Do not submerge or allow a
large volume of fluid to enter the interior of
the simulator.
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Additional Care
Maintenance, and
Warnings

STOMA AND BREAST INSERT
GUIDELINES, WARNINGS, AND
MAINTENANCE

The breast examination inserts and stomas
are constructed from materials that
approximate tissue texture; therefore, use
the same gentle techniques as you would
when working with a patient.

WARNINGS

Always palpate using the fatty pads of the
fingers. Do not palpate using fingernails.

Do not clean with alcohol or aggressive
solvents.

Do not pack any sharp objects with the
stomas.

Do not press the stomas against soiled
surfaces, ink, or newsprint. The stoma
material is absorbent. Always handle the
stomas and breast inserts with clean hands.

When removing the stomas, gently separate
the stoma flange from the torso, and do not
apply force directly to the stoma tissue itself.

Prevent items from resting or pressing
against the stomas and breast inserts as
indentations will form on the pressure points.

Do not pack any sharp objects with the
breast inserts

MAINTENANCE

Apply talcum powder on the stomas and
breasts inserts surface to reduce tackiness
and restore the surface to a skin-like feel and
appearance.

Clean the stomas and breasts inserts using
a mild solution of soap and water.

Always remove the stomas and breast
inserts before transporting SUSIE.

Store the breast examination inserts facing
down inside the protective case when not in
use.
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Electrical Therapy

Only deliver electrical therapy when the
simulator is fully assembled, dry, and
undamaged.

Make sure the defibrillation patches on the
simulator are in good condition, including
removing any and all gel residue on the
defibrillation patches from previous use(s). It
is a good practice to remove gel residues
after every use. Failure to do so will leave
behind a film of electrode gel that hardens
causing arcing and pitting.

Do not re-use the gel-adhesive pads. Do not
leave them on for next day use.

Use hard paddles or wet-gel pads preferably.
Avoid using solid-gel pads since they
present higher risk of burning the simulator’s
skin.

Gel pads have a shelf life. Make sure they
are not expired to avoid arcing.

Make sure the simulator is not in contact with
any electrically conductive surfaces.

Use the simulator only in a well-ventilated
area, free of all flammable gases.

NEVER attempt to service or modify any of
the electrical connections, especially those
between conductive skin sites and the
internal electronics. Discontinue use if any
wires are found exposed with damaged
insulation.

Real medical products, especially
electrodes, sometimes use powerful
adhesives that can be difficult to remove. A
gentle, degreasing cleanser may be needed.
Refer to Care and Cautions for more
information.

Electrode gel on the skin between any two
electrode targets can become a pathway for
electrical current, just as in real life. If this
occurs, Susie's skin can be burned.

Do not allow defibrillation pads to overlap
ECG sites. Doing so will may damage the
simulator and cause arcing.

Should dark traces appear on the conductive
patches due to gel residue or previous
arcing, use a pencil eraser to remove the
traces and then clean with alcohol.

DO NOT SCRATCH the conductive patches
with abrasive objects; doing so will cause
irreversible damage to the conductive sites
and subsequently cause arcing.
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Getting started
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Simulator Setup

LEG ASSEMBLY

1. Remove the fixed bolts from the knee
joints using the hexagonal wrench
included.

2. Connect the pedal pulse cable.

3. Position the lower legs and insert the
knee joint bolt. Tuck in any extra wire
and the connector into the lower leg.

4. Replace the bolt and use the two
provided hexagonal wrenches to secure
the knee bolt without over tightening.

BREAST INSTALLATION

SUSIE’s breast examination inserts are
shipped in a protective case. There are two
right breasts labeled (R1, R2) and five left
breasts (L3, L4, L5, L6, L7). For detailed
information on pathology of each breast,
refer to the “Working with the Simulator”
section.

WARNING: Always store the breast
inserts inside the protective case after
simulation and during transport.

To install or replace SUSIE’s breast inserts:

1. Extend SUSIE’s arms on a flat surface.

Unfasten the skin from the hook-and-
loop fastener located on both shoulders.

Unfasten the skin from the hook-and-
loop fastener located laterally. The skin
will remain attached to the metal bolts
located on either side. Do not remove
the hip bolts.

Lift the skin slightly to expose the chest
cavity
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WARNING: Only lift the skin to the point
shown on the figure below. Lifting the
skin higher can cause damage to the skin
at bolt connection.

WARNING: Do not pull the skin's ECG
lead connection located on the left side
of the chest cavity. Damage to this
connection will require repair not covered
under warranty.

Carefully place the breast inserts
beneath the chest skin. The breast
inserts must be installed in right/left
pairs (e.g. R1/L3, R2/L6).
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After the breast insert’s placement is
adjusted, tightly secure the chest skin by
first adhering the hook-and-loop
fastener located on both shoulders.

Adjust the opening reserved for the AC
adapter

Tightly fasten the skin’s lateral Hook-
and-loop fastener.




Use the protective case to store the inserts
when the simulator is transported or not in
use. Prevent items from resting or pressing
against the breast as indentations will form
at the pressure points. The breast may
return to the normal shape after the pressure
is relieved.

BATTERY

SUSIE is shipped with the internal battery
disconnected.

Connect the battery clip connector located
on the simulator’s right side and then tuck
the connector underneath the skin.

Connect the AC power adapter to the power
input port located on the simulator’s right
side.

BATTERY LIFE

The AC adapter’s status indicator light
displays red when the battery is charging
and green when the process is complete.

Feature Run Time

Internal Battery 4 hours

To display the battery level, the Gaumard
control software must first establish a
connection with the simulator. For more
information about the battery level indicator,
go to the “Working with UNI” section.

WARNING: Do not store the simulator
with a discharged battery. It is good
practice to re-charge the battery at the
end of every simulation session. In
addition, make sure the battery is re-
charged at least every 30 days even if
the simulator is not being used;
otherwise, permanent loss of capacity
might occur because of self-discharge.
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Control Tablet PC

The tablet PC is preloaded with the UNI
control software used by the facilitator to
initialize the simulator and control the vital
signs.

Before turning on the computer for the
first time, please review the
documentation included with the
product for important care and
warning information.

Secure the RF communication module to the
tablet or PRO+ computer using the hook-
and-loop patch. The tablet is now ready to
communicate with the simulator wirelessly.
For information about the signal strength
indicator, go to the “Working with UNI”
section.

STREAMING AUDIO HEADSET

USING THE STYLUS

The tablet’s stylus is a pen-shaped input
used to interact with files and programs.

e Left click - tap the screen with the
pointer. Tap twice rapidly to double-
click.

e Right click - tap and hold a highlighted
item or hold the button near the pointer
and tap the item or text.

CALIBRATING THE STYLUS

As part of the initial setup process, calibrate
the stylus using the Tablet and Pen
calibration tool in the Windows® control
panel. Complete the calibration process
while holding the pen in a natural writing
position for greater accuracy during normal
use.

WIRELESS COMMUNICATION
USB MODULE

The controlling computer transmits the
startup and control commands to simulator
through the USB RF communication module.

Connect the RF communication module to
an available USB port on the tablet.
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The computer system includes a headset
that allows the facilitator to speak as the
simulator’s voice and listen to the
participants reply.

Connect the headset MIC and Speaker
connectors to the designated ports on the
side of the tablet PC. Go to the “Working
with the Simulator” section for more
information about the streaming voice
feature.

Always connect the streaming audio
headset before starting the UNI
software.




Virtual Monitor

The Gaumard Monitors software displays
Susie’s simulated vital signs in real time. The
interactive monitoring software is preloaded
in to the virtual monitors PC.

The virtual monitor PC also allows the
facilitator to play back the session recordings
stored in the PRO+ PC for debriefing.

10:25:08 |

VIRTUAL MONITOR PC SETUP

To verify the wireless link between the two
computers, click the wireless icon located on
the task tray. The wireless network name is
configured at the factory and may differ from
the one seen below. To troubleshoot
connection issues between the virtual
monitor computer and the controlling tablet,
please go to the Appendix.

Currently connected to: *5

=3 Unidentified network
Mo Internet access

Wireless Network Connection 2 A

GaumardNet Conrected :.'._
gaumard :"._

Other Network -l

Open Network and Sharing Center

[l

eie [ . 40 254PM

GAUMARD MONITORS

Refer to the manufacturer’'s documentation
included with the virtual monitor system
components for important safety, installation,
and start-up information before turning on
the PC for the first time.

To setup the virtual monitor PC:

1. Place the all-in-one PC within line of
sight of the controlling computer

2. Connect the power supply to the PC and
to the wall outlet

3. Connect the USB keyboard and mouse
receiver to the PC

4. Turn on the computer

VIRTUAL MONITOR WIRELESS
CONNECTIVITY

The control PC and the all-in-one virtual
monitor PC establish a wireless link at
startup automatically. The wireless
connection allows the Gaumard control
software to transmit the vital signs
information to the Gaumard Monitors
software.

After the wireless connection is established,
double click or tap the Gaumard Monitors
icon to start the vital signs software.

VIO

The Gaumard Monitors software is now
ready to receive the vital signs information
generated by the UNI control software.

12:10:29 |

For more information about the Gaumard
Monitors software, please refer to the
Gaumard Monitors user guide.
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Working with UNI
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Initializing the
Simulator

After reading the manufacturer’s care and
caution information, press the power button
to turn on the Tablet PC.

The UNI software initializes the simulator.
Double click the UNI icon on the tablet’s
home screen to start.

Gaumard
Monitors

Gaumard_ Ul

The simulator selection menu is shown.
Select Susie and click “Start”.

I ®
Gaumard

Simulators for Health Care Education

Please select one simulator
| -

& HAL® 51000

@ SUSIE® S$1001

9 SURGICAL CHLOE®

@ PEDIATRIC HAL® FIVE YEAR

@ PEDIATRIC HAL® ONE YEAR

A
(‘"I‘ NEWBORN HAL®

& |
@ | NFWRORN HAI @ 554 555 2

START't

The wireless link between UNI and the
simulator is established within 1 minute.

PROFILES AND OPERATING
MODES

After the startup screen, the profile and
operating mode selection menu is displayed.

Noelle® 57X.100 - Profiles...

OPERATING MODE

PROFILES DESCRIPTION

Default Profile factory preset scenarios

Noelle Advanced

[cuick startoete |

l New Profile H Rename H Delete i

C:\Program Files
(x86)\Gaumard
Scientific\UNI\profiles\

ow, B

The UNI control software has two modes of
operation: Manual and Automatic. Each
mode includes a Quick Start profile with
preprogrammed scenarios exercises created
in conjunction with experienced healthcare
instructors and working medical
professionals. Continue to the next section to
learn more about the each operating mode
and the profiles included.

After selecting an operating mode and
profile, click “Load” to continue.

MANUAL MODE

In the “Manual” operating mode, the
facilitator fully controls the vital signs and
physiologic responses.

Susie® - Profiles...

OPERATING MODE

Manual

PROFILES

Default Profile

|Quick Start Susie M |
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The Manual mode includes the following
profiles:

Default Profile — includes one palette with
healthy vital signs.

Quick Start SUSIE — contains eleven
scenarios

AUTOMATIC MODE

The Automatic mode assists the facilitator by
automatically adjusting vital signs in
response to caregiver participation,
pharmacologic intervention, and manual
input. For example, when facilitator
increases the heart rate, the Auto mode will
calculate the response and adjust the blood
pressure automatically. To activate the
operating mode as an upgrade option, go to
digital UNI user guide

Noelle® 57X.100 - Profiles...

OPERATING MODE

O ]

DESCRIPTION
Noelle Modeling Scenarios

[ Newprofile | [ Rename |[ Delete |
— _ || C:\Program Files

(x86)\Gaumard
Noelle® 57X.100 Scientific\UNI\profiles\

The Automatic mode includes the following
built-in profiles:

Default Modeling— includes one palette with
healthy vital signs.

Meds Profile — This profile contains fifty-two
pre-programmed drugs to be used on
simulations.

Quick Start SUSIE Modeling — includes
scenarios configured for the Automatic
operating mode

MANAGING PROFILES

Use the Manage Profile Menu to create a
new profile and edit this profile.

Also the profile folder location will be shown
below the “New Profile” icon.
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C:\Program Files e
(x86)\Gaumard
Scientific\UNI\profiles\ Lol [

T 1T 1

Use the “Map Profiles folder® icon to select
the location of the new profile to be created
on the server.

Noelle® 57X.100 - Profiles...

4 &, Local Disk (C)|

b dell T
Ju Drivers

» J Hotfix
b4 Intel

© Ji NVIDIA I
U Perflogs

v 4 Program Files
1. Program Files (+86)
L. SimFacts

<

(

[ Make New Folder |

Select the server location and click “Make
New Folder” to create the profile folder.

Noelle® 57X.100 - Profiles...

4 &, Local Disk (C))
b dell
| Drivers
b i Hotfix
> L Intel
([ |

b i NVIDIA

b 1 Program Files

¢ -1 Prooram Files )

Assign a name to the folder and click “OK”

The new profile folder location will show up.
Then proceed to create a new profile, see
instructions detailed below.

_E_

| New Profile || Rename || Delete

C:\Noelle\ . .
| oap || cancel

Use the “Home” icon to reset to default
profiles folder.



CREATING A NEW PROFILE

Profiles store palette, scenario, and option
settings independently; changes made to
one profile have no effect on the others.
Below are some examples on how profiles
are used.

e Assign one profile to each user of your
Gaumard simulator system

e Use profiles to organize and protect
palettes and scenarios

e Create a profile dedicated to a specific
academic course taught by multiple
instructors

e Devote an entire profile to one particular
subject area, or even one particular
scenario

To create a new profile, click “New Profile”.

New Profile | Rename H Delete |
C:\Program Files =
(x86)\Gaurrard o ﬁ
Scientific\UNI\profiles\ Uy L]

Enter a name for the new profile followed by
a description.

Create New Profile...

Profile Name:
PIN
Noelle [
Enabl_e PIN
Profile Description: ST
OB Simulation Enter PIN :
Re-Enter PIM :
Include contents
of Default Profile
i - Copy current
Include contents OR prog;fe
of Quick Start
Noele® 57X.100

Enable the PIN protection to prevent
unauthorized users from accessing or
making changes to this profile.

Lastly, click “Create” to save the new profile

Click “Rename” or “Delete” to change the
name of delete this new profile.

Noelle® 57X.100 - Profiles...

'OPERATING MODE

DESCRIPTION
L

| wawac |
‘NemeﬁleH Rename H Delete ‘
C:\Noelle\
= )
2@
| oap || cancel |

For more information of the UNI software,
refer to the digital User Guide under
Menu/Help/Instruction Manual.
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UNI Interface

The UNI software is used control the simulator, monitor the vital signs, and evaluate the provider's
performance. The simulation technician or instructor carrying out the simulation operates the UNI
software

The UNI control elements and scenario programming procedures are consistent throughout the
Gaumard family of high fidelity simulators. Some software controls and features covered in this
guide may be hidden depending on the simulator’s hardware configuration and optional upgrades

¢ UNI™ - Susie® (S0000001) - QUICK START SUSIE

none

dosed

R:5/L:5

R:On/ L: On

0.5 sec

off

B

\ / 40| :

normal(3) / / RR °
/ / T 12 mmHg

98
normal 5/09/2014

PNl 13 bpm PALETTE | SCENARIO BRANCHSCENARIO LAB | SPEECH CPR  PROVIDER ACTIONS
= |insp. % 33%

02 sat 98%

40 mmHg

normal(A:2/P:2)
normal(A:2/P:2)
normal(A:2/P:2)
normal(A:2/P:2)

gl @ O oooos-

Simulator will not initialize until connected to
CONNECTION STATUS the charger or the battery is replaced with a
fully charged spare.

The communication indicator displays the
status of the radio link between the tablet’'s
USB RF module and the simulator. Full bars

indicate excellent communication (i.e., WARNING

normal operation).
Turn Simulator OFF before replacing the

I I I I battery. Failure to do so could result in
III III III III serious damage to the system.

BATTERY INDICATOR

The battery indicator displays the battery :
: . : 7 Feature Runtime
charge information. An exclamation sign is
shown when there is no communication with
. . . Internal Battery Approx. 4 hours
the simulator and battery information cannot

be retrieved.

D ED E) =D

When the battery icon is depleted, the
simulator is set to STAND-BY mode
automatically to protect some of the
simulator’s internal components.
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SESSION CLOCK

POWER/STAND BY

The session timer displays the duration of
the current session. Click the timer to reset
the clock or to start a new session. Event
entries in the text log are synchronized with
the session timer.

L Leg Bleed Off | x || TS

o |

New Session

Reset Session Clock

L_me

The power button is located at the bottom
right corner of the UNI software. Toggle the
power button to set the simulator to stand-by
mode and then again to resume.

T n Q ‘,@] e

For more information about the UNI
software, refer to the digital User Guide
under Menu/Help/Instruction Manual.
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Status / Details
Controls

The Status/Details panel is used to monitor
and control the simulator’s vital signs. The
individual parameter controls displayed on
the details tab provide the simplest method
for controlling the simulator’s vital signs,
sounds, and features.

The Status/Details tab displays the vital
signs controls in a list format.

SYSTEMS LIST VIEW

STATUS/DETAILS
CEPHALIC

L Throat Sound(Vol)

normal(3)

BREATHING +
Resp Pattern |l
0 normal| X
RR 13 bpm| x|
Inspire 33% x|
,\ 02 sat 98% | x|
L ||
4 r EtCO2 40 mmHg | ¥
Lung Sounds(Vol)
Right normal(2)
Left normal(2) E|
“ CARDIAC +
' EKG Sinus | |
HR 75 bpm| x|
Heart Sound(Vol)
—&:- normal(2)|x

CIRCULATION
BF 120/80 mmHg

K Sounds L:2

=

Temp 37.5°C

STATUS/DETAILS X

BREATHING
Resp Pattern
normal

* RR 13 bpm

Inspire 33%

02 sat 98%

0 EtCO2 40 mmHg

Lung Sounds(Vol)
Right normal(2)
Left normal(2)

CHANGING VITAL SIGNS

The Status/Details panel is used to monitor
and control the simulator’s vital signs. The
individual parameter controls displayed on
the details tab provide the simplest method
for controlling the simulator’'s vital signs,
sounds, and features.
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To adjust numerical values click the slider
control. (e.g. heart rate, blood pressure,
respiratory rate, etc.).

AL

Throat Sound(Vol)
normal(3)

Resp Pattern

10

RR

11

,_ OAH(![
r EIED H

Alternatively, use the keyboard for manual
entry and click the green checkmark to
confirm the change.

To change patterns, sounds, and rhythms,
click on the specific control to display the
library (e.g. EKG rhythms, heart and lung
sounds, respiratory patterns, etc.)



wf sinus pause
w/ PAC
w/ PIC

s Multfocal atrial tachycardia (MAT)
Atrial flutter

BP Atrial fibrillation
K Sour ||Junctional

@-/ Supraventricular tachycardia
Temp ||1ct deg. AVB

2nd deg. AVB (Type I)

Qnd oo _Avm (Tina

wf PVC (multi.)

w/ couplets
NN —

A

Click the slider control below the sound
library to adjust the volume of the sounds.

isp Patte

none
stridor, inspiratory
stridor, expiratory

————— St[ ik ———
Throat Sound Vol = 2 |¢

~

spire
! sat
o2 © i rﬁ
BP 120/80 mn
K Soung 1
— Left —_——

Left K Sounds Vol = 2

APPLYING CHANGES

No changes will be made to the simulator’s
condition until the new settings are submitted
using the “Apply” panel.

After the list of changes is created, click
“NOW” to update the vital signs instantly.
Alternatively, click a trending timer to update
numerical vital sign parameters (e.g. heart
rate, blood pressure) gradually.

Clear Save Load
Breathing... 2 e
Respiration Rate 50 bpm
Inspiration Percentage 46%

02 sat 30%
Cardiac... 2 e
EKG Atrial fibrillation

skip R's: 10/ min
Heart Sound distant

@
©

Circulation...
Left K Sounds 4

losecl.’:l)secl imin | 2min ISmin lwmin

Flen & & S 3 S __ w~_a_4_sse_ S____

Vital sign parameters can be edited or
removed using the edit and remove
parameter tabs

Enable the “instant apply” option and click
the control to change the vital sign to a new
value without the need to use “Apply” panel.
Vital signs undergoing change blink yellow.
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CEPHALIC

|3 | Cyanosis

[ Throat Sound(Vol)
normal(3) E]

+

normal

RR 13 bpm | x|

Resp Pattern

CREATING PALETTE ITEMS

A palette item stores one or more vital sign
settings into a single loadable object. Use a
palette item to update a set of vital signs
quickly. For example, one palette item can
be created to update all the cardiac
parameters to a healthy state.

To create a new palette item, set the values
for the desired vital signs parameters using
the details controls and click “Save”.

» Details...

Cardiac...

EKG Sinus
Heart Rate 74 bpm
Heart Sound normal

Heart Sound Volume 3

Enter a name for the palette, a description,
and choose color code. Click “Save” to
create the new palette Item. Palette items
are stored in the active profile.

Save as Palette Item

Palette Item Name:

|Hea\thy Heart |

Palette Item Description: H

|Sinus, 74 bpm, Heart Sound Normal |
O] Healthy @] Critical

O Care Required @] Other

When the palette is needed, click the Load
button to select the palette from the library.
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Clear Save Load
Anthony

asystole

Airway... 2 &

Upper Airway Sound none

Breathing... 2 e

Respiratory Pattern normal

Respiration Rate 0 bpm

Inspiration Percentage 33%

02 sat 50%

Lung Sounds Upper Right none

Lung Sounds Upper Left none

Cardiac... [}

EKG Asystole

Heart Rate 0 bpm

Sinus Arrhythmia Off

Heart Sound normal

Circulation... 2 e

Blood Pressure 0 / O mmHg
msec|305ec 1min | 2min 5rri\|10m'n
"1 On Apply: Clear and Close Details Window

ax Details...

Clear

Breathing...
Respiration Rate 50 bpm
Inspiration Percentage 46%
02 sat 30%

Cardiac... 2 6‘

Select the palette item from the “Load
Palette ltem” menu and click “Load”

Load Palette Item...

[ paese|
' Sinus, 74 bpm, heart sound
Healthy Heart Multiple || normal
Gerard
Healthy Resting B
HR drop
HR spike
| 0 ;|| 0]
BT Cencel |

Click the apply option to submit the changes.




Working with SUSIE
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Features

Disclaimer: The section below describes all possible features in the Susie simulator. The content
of this table is subject to change without prior notice. Please contact Gaumard Scientific for the
most current information.

Y = Yes included

O = Optional

Category Feature

Airway Nasal intubation

Airway intubation

Airway complications: Pharyngeal swelling, laryngospasm and tongue
edema

Intubation Sensor

Surgical Trachea: Tracheostomy

Airway sounds

Breathing Respiratory patterns

Lung sounds

Bilateral chest rise

Pulmonary ventilation: BVM, mechanical

Cardiac Heart Sounds

ECG monitoring

Electrical therapy

Circulation | Bilateral pulses - Carotid, Brachial, Radial, Femoral, Popliteal, Pedal

Bilateral IV arms

Automatic blood pressure

Finger stick

Drug Recognition

Cephalic Reactive eyes

Central cyanosis

Seizures

Other Intramuscular injection sites

Interchangeable breasts

Gynecology package

Urinary catheterization

Oxygen saturation

Bowel sounds

Nasogastric feeding

Colostomy

lleostomy

Enema

Streaming audio

Ol<|=<|=x|=<|=x|=<|=<|<|=<|<|=<|<|<|=<lo|<|=<|<|=<|<|<|<|<|<|<|<|<|<|<| < |<]|=<

Virtual vital signs monitor
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Airway

SURGICAL AIRWAY

NASAL AND ORAL INTUBATION

Intubate SUSIE’s airway via the nasal or oral
route using an endotracheal tube or an LMA.

WARNING: Always lubricate the
endotracheal tube and the medical device
using silicone oil before intubating. Do not
introduce liquids into the airway. Doing so
can permanently damage the system.

Recommended Device

Procedure )
Size

Intubation (Blade

. Miller 4 or MAC 3.5
size)

LMA Size 4

8 mm outer diameter
max

Nasal Intubation

Oral Intubation ETT7o0r7.5

AIRWAY COMPLICATION

Use the software controls to enable the airway
complications and make intubation more
difficult. SUSIE can display pharyngeal
swelling, tongue edema, and laryngospasm.

INTUBATION SENSOR

Sensors in the airway detect the placement of
the endotracheal tube. If the endotracheal tube
is inserted too deep, the left lung is disabled
automatically demonstrating right mainstem
intubation. Correcting the tube position
enables the left lung chest rise.

AIRWAY SOUNDS

The simulator can produce audible airway
sounds. Use the software controls to change
the sound type and adjust the volume.
Auscultate using a standard stethoscope.

Susie allows for tracheostomy exercises.
Please ensure the tracheostomy tube is
lubricated prior to insertion.

To replace the cricoid membrane tape on the
surgical airway:

1. Gently lift the neck skin
2. Remove the punctured tape

3. Wrap a new piece of tape around the
trachea opening ensuring an airtight seal

Air leaks in the airway will result in poor
chest rise during ventilation and false
intubation readings.
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Breathing

BILATERAL CHEST RISE

Bilateral chest rise and fall is automatic. Use
the software controls to enable or disable the
lungs independently and to adjust the
breathing rate and the inspiratory percentage.

BREATHING PATTERNS

Control the respiratory rate, pattern, and
inspiration percentage using the software
controls. The breathing patterns are
synchronized with the lung sounds and chest
rise.

RESPIRATORY SOUNDS

The simulator is generates audible upper,
lower, anterior, and posterior lung sounds. Use
the software controls to select between the
available respiratory sounds and to adjust the
volume of each lung independently. The
respiratory sounds include normal, wheezing,
inspiratory squeaks, crackles, and rales.

VENTILATION

Set the respiratory rate to 0 and ventilate the
simulator using a standard bag valve mask.
Open the CPR window to monitor the
provider’s ventilation performance in real time.
Complete the ventilation calibration process
before using the ventilation feature for the first
time.

VENTILATION CALIBRATION

The ventilation calibration wizard records the
performance average of five ventilations as the
benchmark for correct ventilation. Perform the
actions requested by the calibration wizard
following the most current CPR guidelines.
The CPR window evaluates provider
performance based on the benchmark
recorded during the calibration process.

To calibrate the ventilation performance
benchmark:

1. Click Setup > Calibration > Ventilations,
and click “Next”

The wizard prompts to perform ventilation “#1”

2. Perform the first ventilation. A green filled
oval indicates that the ventilation was
recorded successfully
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3. Perform ventilation # 2 as prompted by
the wizard. A green filled oval indicates
that the wventilation was recorded
successfully

4. Continue through the calibration wizard to
record a total of five ventilations

At the end of the calibration process, the
wizard reports the average peak, pressure,
and duration values for the procedure. Click
“Save” to store the calibration settings.



Cardiac

4 LEAD CHEST SKIN

HEART SOUNDS

SUSIE generates audible heart sounds
(normal, distant, systolic murmur, S3 and S4)
which are tied to a user defined heart rate and
selectable rhythms. Use the software controls
to change the heart sound type and volume
level.

ECG MONITORING AND
ELECTRICAL THERAPY

The simulator is equipped with conductive skin
sites that allow the attachment of real
electrodes and defibrillator pads. This feature
allows the provider to track cardiac rhythms
using real medical equipment just like with a
human patient.

The simulator's ECG and defibrillation sites
generate waveforms detectable using real
medical equipment and standard electrodes.
Real automated external defibrillators can
detect the simulator’s heart rhythm and treat
shockable rhythms.

ECG AND ELECTRICAL THERAPY
CHECKLIST AND WARNINGS

Defibrillation is only supported on the large
sternum and apex sites circled RED below.
Do not deliver a shock to ECG electrode
sites on the shoulders or waist marked
GREEN. The warranty does not cover
damaged to the simulator caused by
applying electrical therapy to the ECG
sites.

For exercises that incorporate real
electrical therapy of any kind, always follow
the safety guidelines and operating
procedures outlined in the medical device
manufacturer documentation.

e Always follow the standard medical
guidelines and precautions for handling
electrical therapy devices. Improper use of
a real electrical therapy device may result
in personal injury.

e Operate simulator in a well-ventilated area
free of flammable gases.

e Ensure the simulator is fully assembled,
fully operational, dry, and undamaged
before administering electrical therapy.
Never apply electrical therapy if the
simulator is in contact with a conductive
surface or substance.

e Do not leave electrodes or pads attached
to the conductive sites when the simulator
is not in use.

e Use hard paddles or wet-gel pads
preferably. Avoid using solid-gel pads as
they increase the risk of burning the
simulator's skin if arcing occurs. When
using gel patches, make sure not to leave
air gaps or bubbles between the pads and
the conductive area on the simulator’s
skin to avoid arcing.

e Clean the conductive sites at the end of
the simulation. Refer to the care section
for more information on approved cleaning
products. Gel residue, adhesive residue,
or dirt can increase the risk of arcing
during defibrillation.

e Do not reused gel-adhesive or use
expired pads.
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e Do not attempt to repair or modify any
electrical connections or conductive sites.
Discontinue use if wires are exposed, wire
insulation is damaged, or if any
conductive sites are damaged.

e Electrode gel can become a pathway for
electrical current. Do not allow
defibrillation pads to overlap ECG sites or
gel to carry a current to the ECG sites.
Applying an electrical current to the ECG
sites will result in damage to the
simulator’s internal components.

e Some electrical therapy devices may be
sensitive enough to detect the simulator’s
electrical current for operation. If the
interference is displayed on the ECG
reading, please disconnect simulator's
charger and operate the simulator on
battery power only.

CHEST COMPRESSIONS

Set the heart rhythm to asystole and instruct
the provider to perform chest compressions.
Monitor the depth and frequency of chest
compressions from the CPR trainer window.
Before using the chest compression feature for
the first time, please calibrate the chest
compression feature.

COMPRESSION CALIBRATION

The compression calibration wizard records
the performance average of five compressions
as the benchmark for a correct compression.
Perform the actions requested by the
calibration wizard following the most current
CPR guidelines. The CPR window evaluates
provider performance based on the benchmark
recorded during the calibration process.

To calibrate the compression performance
benchmark:

1. Click Setup > Calibration > Compressions,
and click “Next”

The wizard prompts to perform compression
g

2. Perform the first compression. A green
filled oval indicates that the compression
was recorded successfully

3. Perform compression # 2 as prompted by
the wizard. A green filled oval indicates
that the compression was recorded
successfully

4. Continue through the calibration wizard to
record a total of five compressions
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At the end of the calibration process, the
wizard reports the average peak, pressure,
and duration values for the procedure. Click
“Save” to store the calibration settings.



Circulation

CENTRAL CYANOSIS

Use the software controls to adjust the
cyanosis intensity.

The drug recognition arm is equipped with
a black drain port and a white filling port.
Do not reverse the ports while introducing
fluids into the system; doing so will
damage the system. Do not attempt to fill
the IV system without the black drain
connector in place. Always leave the black
drain port connected during high volume
infusions.

PRIMING THE DRUG
RECOGNITION ARM

BILATERAL PULSES

The simulator’s palpable pulses are blood

pressure dependent. Use the software controls

to disable the distal pulses to simulate severe
hypotension.

DRUG RECOGNITION (OPTION)

The drug recognition feature enhances the
realism of intravenous drug administration
exercises by using tagged syringes
programmed with virtual medications. During
an IV push administration exercise, the drug
recognition system can detect the virtual
medication injected, the dosage infused, and

the administration rate in real time. This allows

UNI to adjust the patient’s vital signs in
response to the virtual medication infused
automatically. For more information on
monitoring medications infused into the drug
recognition arm, go to the Digital UNI User
Guide under Menu/Help/Instruction Manual.

The drug recognition arm can be identified by
the black drain port located on the right
forearm.

WARNING: The simulator must be on
when introducing fluids into the drug
recognition arm. This includes calibration,
purging, draining, IV infusion, and injecting
fluids into the veins or the filling ports.
Introducing fluids into the drug recognition
arm while the simulator is off will damage
the arm and the simulator. Damage caused
by improper use is not covered under
warranty.

The drug recognition sensors are active only
when fluid is present in the vasculature. Prime
the drug recognition arm by filling the forearm
vasculature with fluid. This process should be
completed before simulation begins.

The drug recognition arm is equipped with a
black port for draining and a white port for
filling. Do not reverse the ports while
introducing fluids into the arm; doing so will
damage the system.

Locate the IV Filling kit, which includes the
drainage tube (black tip) and filling tube (white
tip) and filling syringe.

WARNING: Use only Gaumard’s artificial
blood concentrate or clean water to fill the
vasculature. Any other simulated blood
brand containing sugar or any additive may
cause blockage and/or interruption of the
vasculature system.

To prime the drug recognition arm for an 1V
push exercise:

1.
2.

Power on the simulator

Attach the drain tube to the black output
port and place the end of the drain hose
inside a container.

Place the collection container below the
arm level to siphon the fluids in the next
step.
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3. Fill the filling syringe with water and
connect it to the white port.

4. Insert water in the system until fluids exit
through the drainage tube and all air
bubbles are purged.

5. Disconnect the drain tube and the fill
syringe.

PROGRAMMING THE SYRINGES

The tagged syringes supplied with the Drug
Recognition arm must be associated with a
virtual medication and a concentration before
they are used for the first time. The syringes
remain programmed unless the medication
properties are deleted manually using the “Set
Med ID” menu.

To program a tagged syringe with a virtual
medication for use with the drug recognition
arm:

1. Power on the simulator

2. From the Setup menu, click “Set Med ID”.
The Set Med Id option is only available on
simulators equipped with the Drug
Recognition Arm.

The Set Medication Identifier dialog box is
displayed.

== Set Medication Identifier

Instructions:

1. Place the Syringe perpendicular to the forearm.

2. Select a drug from the drop down menu.

3. Designate a volume concentration spedific for this syringe.

4. Click the Add button, then watt a couple of seconds whie the syringe is being programmed.

Concensation fmi
] LU
Syringe Identifier
Place syringe
perpendicular
to the forearm.

Add

' Delete Selected Medication ‘

34 | SUSIE S2000 | User Guide

3. Rotate the lower right arm so the palm of
the hand is facing up, and place the
syringe holder on the simulator’s right
wrist.

4. Place the tagged syringe in the holder.
The syringe must be perpendicular to the
surface of the forearm.

5. Select a drug from the drop-down menu
and enter the concentration.

@ Set Medication Identifier

Instructions:

1. Place the Syringe perpendicular to the forearm.

2. Select a drug from the drop down menu.

3. Designate a volume concentration specific for this syringe.

4. Click the Add button, then watt a couple of seconds whie the syringe is being programmed.

Medication: c /ml
/1

Epinephrine (Primatene, Adrenalin) ~‘ 1

The Syringe Identifier displays “Ready!” when
the syringe is in range.

6. Click the “Add” button associate the virtual
medication to the syringe. Please wait
while process is completed.



Instructions:

1. Place the Syringe perpendicular to the forearm.

2. Select a drug from the drop down menu.

3. Designate a volume concentration spedific for this syringe.

4. Click the Add button, then watt a couple of seconds while the syringe is being programmed.

Medication: Concentration /i
Epinephrine (Primatene, Adrenalin) ‘ 1 1

Syringe Identifier

Ready!

Please wait while the syringe is
being programmed...

— Add

Delete Selected Medication

The syringe is now associated with the
medication type and concentration. The
medication association is listed in the “Set
Medication Identifier” dialog box. Use the
labels provided to identify the syringe with the
medication name and concentration.

Repeat the “Set Med ID” process to program
additional syringes with other medications.

Reuse tagged syringes by reprogramming the
associations. To delete a medication
associated with a particular syringe, highlight
the desired medication from the “Set Med ID”
list and click “Delete Selected Medication”
button.

The medication detection feature can trigger
auto responses. Drug auto responses move
the scenario to the next stage when the drug
type and dosage threshold are detected. To
learn more about programming drug auto
responses in a scenario, go to the Digital UNI
User Guide under Menu/Help/Instruction
Manual.

WARNING

Maximum amount of fluid injected without
draining should not exceed 40 mL and the
maximum injection rate is 9999 mL/hr.

IV ARM

The simulator is equipped with an IV arm that
allows for bolus or intravenous infusions as
well as for drawing fluids.

WARNING

The drug recognition arm is equipped with
a black drainage port. Reversing the fill
and drain connections on a drug
recognition arm will damage the system
and void the warranty. Please refer to the
Drug Recognition section to prime the drug
recognition arm for an exercise.

Do not attempt to fill IV system without the
drain connector in place.

Always leave the drain port connected
when injecting fluids into the system.

Use only Gaumard's artificial blood
concentrate or clean water to fill the
vasculature. Any other simulated blood
brand containing sugar or any additive may
cause blockage and/or interruption of the
vasculature system.

Always flush the IV system with distilled
water at the end of every simulation.

INSTRUCTIONS FOR USE

INSTRUCTIONS FOR USE

To inject fluids into the drug recognition (right)
arm using a tagged syringe:

1. Power on the simulator and select the
Automatic operating mode

2. Fill the preprogrammed syringe with fluid.

3. Inject a vein on the anterior or posterior

right forearm while maintaining the syringe

near the arm.

The tagged syringe must be close to the arm
for the drug recognition module to detect the
medication type.

To prime the IV arm for an infusion exercise or
to draw fluids:

1. Locate the fill syringe with tubing and the
drain tube with pinch-clamp. Fill the
syringe with the desired fluid -- water or
simulated blood.
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2. Connect the syringe with tubing to one
port and the drain tube with clamp to the
other port as shown.

3. Insert water in the system until fluids exits
through the drainage tube into the
container and all air bubbles are purged.

The IV arm is now ready for use.

To simulate a patient with no accessible
peripheral IV sites, connect only the syringe.
Pull the plunger to create suction, which will
collapse the veins. Disconnect the syringe
tube from the arm port while maintaining
suction. The port will seal, and the veins will
remain collapsed.

WARNING: Use only Gaumard’s provided
simulated blood to fill the internal
reservoirs. Any other simulated blood
brand containing sugar or any additive may
cause blockage and/or interruption of the
vasculature system.

Always flush internal fluids with clean water
then air to prevent mold.

Avoid overfilling the fluid reservoir. Doing
so may result in a leak at the bleeding site.

Feature Reservoir capacity

Finger stick 2cc

FINGER STICK RESERVOIR

To fill the finger stick reservoir with fluid:
1. Power the simulator on

2. Fill the modified syringe with 2 cc of water
or simulated blood.

3. Connect the fill syringe to the black port
located closest to the left elbow and
slowly fill the internal reservoir with
simulated blood.

4. Enable the “finger bleed” software control
to produce a drop of blood from the finger

tip

BLOOD PRESSURE (MANUAL)

FINGER STICK

The left middle finger can bleed real fluid
through a precut opening on the fingertip. The
feature allows participants to practice finger
stick technique and collect simulated blood
samples.
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Measure the blood pressure using a standard
sphygmomanometer. Korotkoff sounds are
heard between systolic and diastolic pressure
readings. Before using the blood pressure
feature for the first time, place the blood
pressure cuff on the arm and calibrate the
blood pressure feature using the blood
pressure calibration wizard.

INSTRUCTIONS FOR USE

1. Place the cuff around the simulator’s
upper left arm with the cuff mark at the
medial site of the bicep brachii, about an
inch (two cm) above the anterior elbow.

Place the cuff in the same position used
during the calibration process for
accurate readings.




2. Inflate the BP cuff, and auscultate
Korotkoff sounds just as with normal
patient.

OXYGEN SATURATION

Use a real oxygen saturation monitor to get an
oxygen saturation reading from the left index
finger. Before using the oxygen saturation
feature for the first time, calibrate the simulator
to work with the oxygen saturation monitor to
be used during the exercise.

2. Go to Setup>Calibration and select
“Oxygen Saturation”. Click “Next” to
continue.

3. Turn ON the oximeter and click “OK” on
the dialog box.

4. Adjust the reading on the oximeter
monitor screen to match the value
displayed on the GaumardUI calibration
screen using the arrows on the left column
of the calibration window. The first
calibration point is 98%.

Use the triple arrows to increase or decrease
the reading on the oximeter in large intervals,
double arrows for moderate changes, and the
single arrows for small changes of one or two
percent readings. Wait 10-15 seconds after
making an adjustment to allow the oximeter
reading to stabilize. Doing so ensures proper
calibration.

5. After the reading on the OSAT monitor is
stable and it matches the value on the
GaumardUI calibration window, click “OK”,
and then “Next” to continue.

6. Repeat the process to calibrate the
following intervals.

7. Click “Finish” at the end of the calibration
and remove the OSAT monitor from the
finger.

INSTRUCTIONS FOR USE

OXYGEN SATURATION
CALIBRATION

UNI stores the calibration settings for one
device at a time. If the oxygen saturation
monitor or the sensor is changed, the
simulator must be recalibrated to work with the
new device.

Disclaimer: Oxygen saturation monitors
that detect carbon monoxide and/or
methemoglobin are not supported.

To calibrate the oxygen saturation finger:

1. Turn OFF the oxygen saturation monitor
and place the oximeter sensor on the left
index finger. Verify that the left index
finger is centered inside the finger sensor.

1. Start UNI and establish communication
with the simulator.

2. Connect the oximeter probe to the left
index finger of the simulator.

Turn on the monitor.

Adjust the oxygen saturation using the
UNI software controls.
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Neurologic

REACTIVE EYES

The simulator is equipped with programmable
blinking eyes and pupils that dilate. Use the
software controls to change the blinking rate
and to enable or disable pupil reaction.

PUPIL CALIBRATION

The eye reaction is factory calibrated. Use the
“Pupil Sensitivity” controls to recalibrate the
pupil reaction for the current room lighting only
if needed.

To calibrate the pupil dilation:

1. From the File menu, go to
Setup>Options>Tolerances

2. Click “Set ambient light” to recalibrate the
pupil diameter to the current ambient light.

3. Cover both eyes from most incoming light
and click "Set Dilation Light" to set the low
light pupil diameter.

4. Click increase or decrease to adjust the
pupil’s sensitivity to light

SEIZURES

The simulator is capable of convulsing to
simulate mild or severe seizures. Use the
software controls to enable the seizure
behavior.
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Other

INTESTINAL ACCESS

RESUSCITATION (CPR)

The simulator features ventilation and
compression sensors for monitoring CPR
performance. The CPR window detects
ventilations when the respiratory rate is set to
zero or apneic and compressions when the
heart rhythm is in an unhealthy state.

Complete the ventilation and compression
calibration process before using the CPR
window for the first time. To learn more about
the CPR window, go to the Digital UNI User
Guide under Menu/Help/Instruction Manual.

The rectal opening is connected to the
intestinal fluid reservoir. The rectal opening
can be used for administering enemas and
removing intestinal fluids introduced using an
NG tube (S1004055 or above only).

COLOSTOMY AND ILEOSTOMY

NASOGASTRIC FEEDING

SUSIE (S1004055 and above) supports the
introduction of fluids through the esophagus
using an NG tube.

WARNING: Do not introduce liquids when
performing nasal and oral intubation on
simulators with serial numbers S1004053
or below. Doing so will result in damage to
the simulator and void the warranty.

Participants can perform colostomy and
ileostomy exercises using the ports on
SUSIE’s abdomen.

To administer fluids using an NG tube, the
simulator’s serial number must be S1004055
or above.

e  Maintain the simulator with a 30°
inclination angle or higher.

e  Wait until the software logs the tube
placement (shown in the picture
below)

STOMA AND BREAST INSERT
GUIDELINES, WARNINGS, AND
MAINTENANCE

The breast examination inserts and stomas
are constructed from materials that
approximate tissue texture; therefore, use the
same gentle techniques as you would when
working with a patient.

WARNINGS

WARNING: Inserting fluids before the
software logs the tube placement will void
the warranty and can permanently damage
the simulator.

Feeding tube rate must not exceed 1
mL/second.

Always palpate using the fatty pads of the
fingers. Do not palpate using fingernails.

Do not clean with alcohol or aggressive
solvents.

Do not pack any sharp objects with the
stomas.

Do not press the stomas against soiled
surfaces, ink, or newsprint. The stoma material
is absorbent. Always handle the stomas and
breast inserts with clean hands.

When removing the stomas, gently separate
the stoma flange from the torso, and do not
apply force directly to the stoma tissue itself.

Prevent items from resting or pressing against
the stomas and breast inserts as indentations
will form on the pressure points.

Do not pack any sharp objects with the breast
inserts
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MAINTENANCE

Apply talcum powder on the stomas and
breasts inserts surface to reduce tackiness
and restore the surface to a skin-like feel and
appearance.

Clean the stomas and breasts inserts using a
mild solution of soap and water.

Always remove the stomas and breast inserts
before transporting SUSIE.

Store the breast examination inserts facing
down inside the protective case when not in
use.

INTERCHANGEABLE BREAST
EXAMINATION PACKAGE

The SUSIE includes proprietary silicone breast
inserts that can be used to teach breast
examination techniques. Seven
interchangeable breasts demonstrate
numerous abnormalities, including chronic
mastitis, benign growth, carcinoma, giant
sarcoma, scirrhus carcinoma, and retracted

nipple.

This training tool was developed to assist
health professionals in teaching the processes
and skills required to perform both breast self-
examinations and clinical identification of
pathologic conditions.

S2000 BREAST PACKAGE
FEATURES

Five interchangeable left breasts, which
include fibrocystic disease (chronic mastitis), a
benign tumor with stalk, a giant sarcoma,
scirrhus carcinoma, and a retracted nipple

Two interchangeable right breasts, which
include a normal breast, and a breast
containing lumps of size 8, 10, 16, and 20 mm
for training of breast self-examination (BSE)
techniques.

Can be used to teach the spiral or grid pattern
to improve detection techniques

e Left Breast #1: Six discreet nodes on
one side and a somewhat larger node
on the other side of the breast. This
breast represents (in a slightly
exaggerated form) various stages of
fibrocystic disease (chronic mastitis)
which is due to an endocrine
imbalance and may be found in many
normal women.

e Left Breast #2: There is a solitary
tumor in this breast. It is well
circumscribed and has a stalk. The
tumor can be moved and it is not
adherent to the breast tissue. It is
benign and usually occurs in younger
women.

e Left Breast # This breast shows a
comparatively rare but palpable
tumor: a giant sarcoma (or giant
mammary myxomay) of which the
wildly growing masses can be easily
felt.

e  Left Breast #4: This form of breast
cancer (scirrhus carcinoma) is one of
the more commonly encountered
malignant tumors of the breast. When
palpating, note the infiltrating nature
of the growth. It has no well-defined
borders and cannot be moved within
the breast.

e Left Breast #5: This breast shows a
retracted nipple, and on careful
palpation, a mass can be felt
immediately under the nipple. The
breast represents a carcinoma in one
of the milk ducts.

GYNECOLOGY PACKAGE

BREAST PATHOLOGY

Following is a detailed description of SUSIE’s
seven (7) interchangeable breast inserts:

e Right Breast #1: Normal

e Right Breast #2: Four discreet nodes
of sizes 8 mm, 10 mm, 16 mm, and
20 mm.
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The gynecologic package allows the practice
of various gynecologic procedures such as
vaginal douching, speculum insertion, pap
smear, bi-manual pelvic examination, dilatation
and curettage exercises, placement and
removal of an intrauterine device (IUD),
palpation of normal and 20-week-pregnant
uteri, and inspection of normal and abnormal
cervices.

Al




Verify the simulator’s serial number to
determine which filling procedure
applies.

FILLING THE BLADDER (S1004055
OR ABOVE)

Gynecology Package QTY
Normal uterine assembly (installed) | 1
Seven week pregnant uteri with 1
interchangeable cervix
Twelve week pregnant uteri with 1
interchangeable cervix
Twenty week pregnant uterus 1
Normal patent cervix 4
Parous normal cervix 1
Cervix with proliferation of

L . 1
columnar epithelium (ectropion)
Cervix with inclusion (Nabothian) 1
cyst and endocervical polyp
Cervix with lesion (cancer) 1
Flashlight 1

INSTRUCTIONS FOR USE

To interchange the uterus and/or the cervix

insert:

1. Gently lift the abdominal skin cover

2. Unscrew the large grey ring to unfasten

the uterus from the cervix

3. Unscrew the second smaller ring to

unfasten the cervix

4. Remove the cervix through the vagina

URINARY CATHETERIZATION

To fill the bladder with fluid to perform a
catheterization exercise:

1. Locate the fill kit.

2. Insert the bladder fill adapter into the
urethra.

3. Connect the fill syringe to the urethra
adapter.

4. Fill the bladder with a maximum volume of
240 mL.

5. Remove the urethra adapter and lubricate
the catheter.

SUSIE features an internal bladder used for

catheterization exercises.

FILLING THE BLADDER (S1004053
OR BELOW)

Bladder reservoir

- 240 mL
capacity

Urinary Catheter | 18 Fr catheter

To fill the bladder with fluid to perform a
catheterization exercise:

1. Locate the fill syringe

2. Fill the syringe with the desired fluid
(water or simulated urine)
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3. Connect the fill syringe to the urinary port
in the simulator’'s abdomen shown below.

4. Insert up to 240 mL of fluid.

5.  Remove the fill syringe and lubricate the
catheter.

INSTRUCTIONS FOR USE

INTERCHANGEABLE GENITALIA

The simulator features interchangeable male
and female genitalia.

To install the male genitalia:

1. Remove the female catheter adapter.

2. Insert the male genitalia urethra tube into
the catheter port. Ensure the connector is
secured to prevent leaks.
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Catheterize the simulator using an 18 Fr
catheter lubricated with silicone oil. At the end
of the exercise, drain the fluid from the bladder
reservoir to prevent mold.

Install the female genitalia reducer adapter to
prevent leaks around the catheter.

BOWEL SOUNDS

Use the bowel sound controls to change the
bowel sound types and adjust the volume
levels. Auscultate the bowel sounds using a
real stethoscope.



INTRAMUSCULAR INJECTION
SITES

Intramuscular injection sites are located on
both deltoids and quadriceps for injection
technique and placement exercises.

STREAMING AUDIO

Use the streaming voice to speak as the
simulator’s voice and engage the provider in a
realistic conversation.

INSTRUCTIONS FOR USE

Ensure that the headset and microphone is
connected to the PC before starting the UNI
software. The headset minimizes echo and
environmental noise to improve audio quality.

Click the “talk” icon and speak in to the
headset to talk as the simulator’s voice.

i Team \é‘:
8 (
| Ed ®
Ly
Streaming Audio
Talk

To listen to the provider’s response, click

“Listen”.
S
N O,
14
Streaming Audio
Listen

Reference the UNI software User Guide for
information on additional streaming voice
features and functions.
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More about scenarios

THINKING IN TERMS OF PALETTE ITEMS

As described previously, palette items represent complete or partial groups of settings that have been stored as a single
item. Applying partial states will hold constant all settings that are left unspecified.

Not only does it take time to customize the palette, but a very large palette becomes difficult to navigate. So, it is desirable
to minimize the number of Palette Items in each Profile. To accomplish this, an experienced facilitator tries to create items
that are as generally applicable as possible and can therefore be applied to a wide range of scenarios. The key is to
include only in your palette items the settings that are directly related to the physiological event represented by that
palette item.

SMART SCENARIOS

After reading the Details, Palette, and Scenarios sections of this guide, it should be clear how to build a scenario. You
may have already tried building your own or modifying some of the factory presets. The following four guidelines will refine
your ability to build the best possible scenarios.

1. How will the scenario begin?

The first thing to consider is the initial condition of the patient. Create a Palette Item to describe this condition. Make sure
that this first step in the scenario is a complete state. That is, indicate some selection for each available setting on the
Status/Details panel. Remember that only the settings you specify will cause a change in the simulator, and all other
settings will remain constant. Therefore, by starting with a complete state, the simulator’s condition will always be the
same when the scenario starts, regardless of what she was doing previously.

Likewise, the "transition duration" of the first step in the scenario should be zero, indicating that changes are applied
immediately.

There is one point that can cause confusion and warrants further explanation. It UNlis an extension of the above
discussion of partial states. The issue is best illustrated through the following example:

Suppose that you are creating a Palette ltem to start your scenario. In this case, you have decided that the patient will be
apneic. The question is, "How should the lung sounds be set?"

Most people's first inclination is to set the lung sounds to "none.” This is incorrect, despite apnea. Obviously, no lung
sounds should be heard during apnea, but since you have already set respiratory rate to zero, none will be. (Sounds are
synchronized to the breathing cycle.)

What you are really setting here when you choose a lung sound is the condition of the lungs, given respiratory drive. That
is, if the patient's respiratory rate were changed from zero, what sound would be heard? Assuming that the lungs
themselves are normal in this scenario, you would choose "normal” for the lung sound setting.

Then, as the scenario progresses, if the patient starts breathing, there will be no need to set the lung sound again. It will
already be set. The same principle applies to the heart sound and other settings.

2. Include notes to guide the facilitator during the simulation.

It is common for scenario designers, especially those who act as facilitators, to neglect the importance of notes in the
scenario. They think that they will remember the learning objectives, patient history, and other details at the time they are
ready to conduct the simulation. They usually do not, especially when revisiting a scenario months after creating it.

When you add "Wait" and "Wait Indefinitely" steps to a scenario, you have an opportunity to edit the item description. Use
this description field to hold notes to the facilitator. Typically, scenario designers write notes in that space to indicate what
the provider(s) or facilitator should be doing at that point.

Further, when saving the scenario, you may edit the scenario description. This is the best place to put patient history and
any other longer notes and instructions.

3. Assume that providers will do the right thing.

Usually a scenario should be created with the assumption that the providers will perform correctly. As long as they do, the
scenario can be allowed to continue.

Naturally, preparation must be made for what might happen to the simulator when providers deviate from expectations.
The consequences of such deviations can sometimes be included in the scenario, punctuated by "Wait Indefinitely" items.
In other cases, the simulation will require more direct control by the facilitator via either the Palette or Status/Details panel.

4. Choose auto-response settings based on the scenario content and the objectives.
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As seen, auto-responses can be used to free the facilitators’ attention. They also enhance realism by presenting instant
reactions to the care providers. On the other hand, sometimes it is not possible or desirable to determine the responses
before the simulation begins. Different environments and applications call for different settings.

Some teaching practices are best done with the auto-response settings in Prompt mode. Responses must be triggered by
a vigilant facilitator. Though it is slower and requires more attention, the benefit of Prompt over other modes is that the
simulation can be allowed to go in any direction, and it will be possible to choose the response on a case-by-case basis.

Other learning exercises require a higher degree of automation. For such applications, most facilitators choose Auto mode
for the auto-response settings. The key issue is standardized timing of symptom presentation. A consistent, repeatable
simulation is essential for fair assessment of that care provider in relation to others and for the broader interpretation of
results in the context of training validation studies.

When in doubt, it is best to choose Prompt mode, in which the facilitator will be given direct control of the responses as
events are detected
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Factory Preset Scenarios Flowcharts

MANUAL MODE

Scenario Name Type Linear or Branching
1. Bradycardia Adult ALS Branching
2. Chronic Liver Failure Systemic Linear
3. Chronic Obstructive Pulmonary Disease (COPD) Respiratory Branching
4. Closed Head Injury Neural Branching
5. Congestive Heart Failure (CHF) Cardiac Branching
6. Ischemic Stroke Cardiac Linear
7. Pancreatis Systemic Branching
8. Pulseless Arrest Adult ALS Branching
9. Spinal Cord Injury (SCI) with paralysis Neural Branching
10. Acute Coronary Syndrome STEMI Cardiac Branching
11. Tachycardia — pulse Adult ALS Branching
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Susie® S2000
Gaun?arq’ B Bradycardia
Simulators for Health Care Education

Adult ALS

An in-hospital patient is diagnosed with Bradycardia and requires immediate attention. Note: for this
scenario to function as intended the instructor should enable automatic pacing capture in the 'Setup -
> Auto-Responses' menu.

Bradycardia
HR 50 Complaint — “Feel
BP 90/60 » dizzy”
RR 10
02 Sat 96%

Wait
No changes made
Transition 2 min

Confusion — “What
happened?”

Atropine Administered

Pace

Epinephrine Administered

Dopamine
Administered

Pace Response
BP 100/70
®  o2sat97%
1:00
Epinephrine
Administered
Dopamine
Administered
> A v
Atropine Administered | Wait Indefinitely Pace
A 4
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Urgency —
“OUCH!!,” “That
Hurts,”
“OUcCH!”



Susie® S2000
Gagmard - Chronic Liver Failure
Sl Systemic

Patient reports to doctor complaints of increasing weakness, poor appetite, and increasing
abdominal distention that is making it harder to breathe. She has been producing dark-colored urine
and notices a yellow discoloration of her eyes. Mrs. Gonzalez is a known alcoholic who has been
hospitalized twice in the past few months for vomiting blood. She says that she has been unable to
cut down on her drinking. She has a PMH of alcoholism for the past 20 years and associated
complications including gastritis, alcoholic hepatitis, and aspiration pneumonia. Mrs. Gonzalez takes
no medications and has no known allergies.

Liver Failure Init
HR 86
BP 138/86
RR 35
02 Sat 92%

Complaint —
“Abdomen Hurts”

'.
Wait
No changes made
Transition 30 sec

A

'.
Wait
No changes made
Transition 30 sec

y

Liver Failure 2 Complaint —
HR 90 » Puking blood
RR 38

\/\

. Complaint —
e Coughing Up
No changes made »
" Blood
Transition 15 sec

“
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Gaumard’

Simulators for Health Care Education

Susie® 2000
COPD
Respiratory

(Chronic Obstructive Pulmonary Disease). A 74 year old female patient was admitted to the hospital
yesterday for increased dyspnea and elevated mucus production. She looks thin and poorly

Confusion — “What
happened?”

nourished.
Effect — Cough
Wait
No changes made <
Transition 1:30 min
Temperature Treatment: Potgntlal Nebulizer Treatment and nasal O2
Actions
No Action
Confusion — “Are
you a doctor?”
Lorazepam and No action
Solu-medrol
Central line
4
COPD 3
HR 91
BP 140/70
Cardiac Rhythm sinus o
RR 18 ”

02 Sat 98%
Lung Sound crackles
Transition 0:45
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No Action

Open Airway and begin CPR



Gaumard’ Susie® 2000
Simulators for Health Care Education Closed Head Injury

Neural

- Perform a focused neurological assessment of a patient with closed head injury.

- Perform serial neurological checks as ordered and record on the appropriate form.
- Perform a complete pain assessment and reassessment.

- Recognize agitation in a closed head injured patient and provide appropriate relief.
- Report abnormal neurological findings to the physician.

- Take verbal physician's orders and provide appropriate read-back of the orders.

Head Injury Start
HR 80
BP 104/72
RR 16
02 Sat 98%

|

Wait
Wait for assessment
2 min

v

Agitation
Seizures Mild

Calls MD for agitationJ

—

Neuro decline 1
HR 65
BP 120/70 No Action
RR 13
02 Sat 92% y
Neuro decline 2
HR 56
N BP 144/68
RR 10

No Action

No Action

Call MD for neuro change

No Action
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Susie® $2000
Gaumard” CHE

Simulators for Health Care Education .
Cardiac

(Congestive Heart Failure). Wendy Morgan, 58 years old.

Wait Indefinitely
Wait for actions

<
<

Potential
Actions

Complaint — Wait
Feel Weak No changes made
1 min

J)

%

!

Complaint —
Short of breath
Complaint —
Feel nauseous
v
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Susie® S2000
Gaumard Ischemic Stroke
Simulators for Health Care Education .

Cardiac

This 66 year old female was at home watching TV when she developed an onset of slurred
speech. She was transported to the Emergency Department by EMS. A head CT scan
confirmed she was suffering an acute ischemic stroke.

Complaint —
“Worst
headache”

Wait Indefinitely
Waiting for Heparin and
Labetolol

Wait Indefinitely
Waiting for MRI to be
ordered
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Gaumard’

Simulators for Health

Care Education

Susie® S2000
Pancreatitis
Systemic

Jane Ellen, 45yo.

Gl Assessment
Obtained alcohol intake hi

Perform complete pain assessment

story ———»

Wait Indefinitely
Wait for actions

Assess the patient

Complaint — Wait
Abdomen hurts |« Wait for other assessments
1:00

=T

Complaint — Feel
nauseous

\/\
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Establish IV
Administer Pain Reliever
Administer Antibiotics

Potential \
actions

Slight Improve

Wait Indefinitely
Wait for actions

Pain reassessment
Administer antidepressants
Insert NG tube, low intermittent suction

No Action




p. . Susie® S2000
[ Gaumard Pulseless Arrest
) Simulators for Health Care Education

Adult ALS

A young female was found unconscious.

Wait Indefinitely for
provider actions

Potential
Actions

Y Y B P X t P ¥ Y P ¥ ¥ Administer Ad i
rogress rogress to rogress rogress o . minister Adenosine
oAdden Prtc;g\r/T:ss to PEA Healthy to SVT ;rt\)/grr(ae:; to ?ﬁ::;m::‘eﬁrcAgzgc’;li Non-Therapeutic
%9 (SVT) Patient with pulse Asystole P P Response
4
PA - OSat
Increase 1
Osat +2%
L h 4 A4
A
Healthy Resting
HR 75
BP 120/80
RR 13
Osat 99%

User Guide | SUSIE S2000 | 55




' Susie® $2000
Gaumarq N SCI with Paralysis
Neural

(Spinal Cord Injury). With this scenario, care provider may:

- Perform post-operative assessment of a client with spinal stabilization.

- Perform neurological assessment of a client with spinal cord injury resulting in paralysis.
- Perform complete pain assessment and reassessment.

- Administer medication according to physician orders via multi-med line.

- Evaluate responses to opioid reaction after administering medication as ordered.

- Perform administration of narcotics via a PCA pump.

SCl initial
HR 95
BP 120/60
RR 24
Lung sound Crackles
02 Sat 98%

|

Wait Indefinitely
Wait for morphine

Morphine
Administered

Wait Indefinitely
Manually progress to
opioid response

Narcan
Administered

No Action
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Gaumard’

Simulators for Health Care Education

Susie® S2000
STEMI
Cardiac

about chest pain.

Mrs. Jones is 63 years old. Her son brought her to the ER because she is complaining

No Act

ion

STEMI Initial State
HR 80
BP 152/90
RR 20
02 Sat 96%

v

Wait
No changes made
55 sec

Complaint —
Chest Hurts

Potential

=

Wait
No changes made
15 sec

Complaint —
Can't catch
breatf

No Action

=

No Action

No Action Proceed to

Agonal rhythm

*»NO -

——02 Delivered

~ Proceed to
Stable STEMI

Actions

02 Delivered

Complaint —
Jaw Hurts

Proceed to
stable STEMI

STEMI Stable
HR 85
Cardiac rhythm Acute
inferior M1
RR 30
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A Susie® S2000
1 Gaumard” Tachycardia — pulse
imulators for Health Care Education Adult ALS

SVT with pulses. Note: this scenario can progress directly to the Pulseless Arrest scenario. To do so,
load "Pulseless Arrest" after stopping this scenario while on Node 2.

Responsive SVT —
HR 165 Complam}.
BP 80/55 > Hea’} b‘:at'"g
RR 22 as
02 Sat 25% -~ -
4 Complaint:
Wait Heart trying
0:10 7] tojump
Wait
2:00
Wait for student’s

action before the
situation worsens

<
A Potential
Actions
Vagal Administer
maneuvers Adenosine:
non therapeutic
10 seconds
Administer
Adenosine:
therapeutic
y
Wait Indefinitely Tach vagal
Waiting for provider —— maneuvers
actions —— HR-10%
BP +5%/+5%
Osat +2%
SVT recovers

HR 80
BP 130/90

RR 13
Osat -97%

) 4
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AUTOMATIC MODE

Scenario Name Type Linear or Branching
Bradycardia Adult ALS Branching
Pulmonary Edema Systemic Branching
Tamponade Respiratory Branching
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Susie® $2000
Gaumard Bradycardia
Simulators for Health Care Education

Adult ALS (Automatic Mode)

(Karen). An in-hospital patient is diagnosed with Bradycardia and requires immediate attention .
Note: for this scenario to function as intended the instructor should enable automatic pacing capture
in the 'Setup -> Auto-Responses' menu.

Bradycardia

HR 45
BP Auto
RR 10
02 Sat Auto
Contractility 70%
v
Speech — Feel
Wait Indefinitely dizzy
\_/_\
v
Wait Speech — What
Wait for student action happened
Transition 2 min

\/\

Wait
Pacing expected
Transition 2 min

YES NO

Pace Response
Speech — Ouch, BP Auto
that hurts, Ouch RR Auto

02 Sat Auto
Contractility 80%

© 2010 Gaumard Scientific
All rights reserved
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Susie® S2000
Gaumard Pulmonary Edema

Simulators for Health Care Education

Respiratory (Automatic Mode)

The patient is found complaining of chest discomfort and shortness of breath. She is wealk,
lightheaded, and diaphoretic.

y

To Pulseless Vtach Wait Indefinitel Times out
(After transcutaneous pacing) y In 10 seconds

To Asystole
(No Transcutaneous Pacing)

Times out in 10 seconds

Pulse Returns
HR: 85
BP: Auto
Successful——p RR 15 -
OSat: 95%
NSR
Contractility 100%

Unsuccessful

Times out in 10 seconds

Unsuccessful

L *

Successful

© 2010 Gaumard Scientific
All rights reserved
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‘ Susie® S2000
kL TOOR Tamponade
‘ Trauma (Automatic Mode)

(Maria). The patient was found injured in a high speed collision after drag-racing on the
expressway. She lost control of vehicle and crashed into a highway divider. BAC: 0.10.

YES
Synchronized Cardioversion Wait Indefinitely ————Perdiocardiocentesis
choose not to convert) Hold until action is taken ]
< To PEA
NO
YES To Asystole
To VFib
Times out in 10 seconds
y

© 2010 Gaumard Scientific
All rights reserved
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Troubleshooting

Use the following table to find causes and solutions to a number of possible problems.

Symptom

Possible Cause

Solution

Communication never gets
established or is lost

(blinking communication

Battery connectors in the simulator
are reversed

Make sure to connect red wire to red terminal,
and black to black

indicator is consistently red)

Battery is discharged

Make sure battery is charged.

Computer is too far away from
simulator

Get simulator closer to computer

Trying to communicate with a
different simulator

Make sure to select the right simulator when
opening the software.

In a multiple simulator environment, make sure
to enter the right Serial Number

Starting more than one simulator
with its own tablet

Select different channels for each of the
simulators, and then turn them on one at a
time, meaning: Wait until a link has been
established between the tablet and

the simulator (the yellow window goes away).

Only after that, start running the GaumardUl
software in the second tablet, and so on for the
rest of the simulators. To do so, go to menu
Setup — Options — Environment — Select
“Auto change to channel: #’ (# = number from
1-11).

All others

Close the GaumardUI software and unplug the
RF module for at least 5 seconds, then plug it
back in.

Disconnect one terminal from the battery and
reconnect after 5 seconds.

Restart the software and wait for initialization

Simulator doesn’t run for
the time specified on the
manual

Battery not charged properly

Make sure that LED indicator on battery
charger goes through the sequence described
in its label, usually red or orange after plugging
it, and then green when charge is completed.

If LED does not go through label’s indications,
then:

Check plug connection making sure it is all the
way in.

Make sure you are using the appropriate
charger, labeled with its simulator name

Simulator doesn’t respond
to any command even that
blinking communication
indicator is consistently
green

The computer is properly
communicating with a simulator, but
not necessarily the one you intend to
control

If you have more than one simulator in your
facility, make sure that your computer is
properly set-up to control the simulator that
you wish to control. Go to Options... on the
Setup pull-down menu and check the
Environment preferences

Commands are taking
longer than usual to take
effect or simulator is not
reporting every action

Distance between computer and
simulator is reaching its limit

or

Get simulator closer to computer or move
away from obstructions
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Symptom

Possible Cause

Solution

(blinking communication
indicator is consistently
yellow)

there are too many obstructions
between (walls, etc)

There’s too much RF interference
either from another Gaumard
tetherless simulator in the vicinity or
an RF radiator.

Try changing the RF channel by going to the
menu for Setup — Options — Environment —
Select “Auto change to channel: #’ (# =
number from 1 — 11).

GaumardUl has set the
power mode to STAND-BY
automatically

The battery on the simulator is
depleted

Plug charger for all others including

"RF module not found"
message is displayed when
GaumardUl is started

RF module not connected

Connect the RF module to any USB port.

RF module not identify by the
computer

Close the software and try disconnecting the
RF module for at least five seconds, then plug
it back in and restart the software

Chest compressions are not
properly detected or not
detected at all

Is the communication indicator panel
consistently yellow?

See solution above in section making
reference to “blinking communication indicator
is consistently yellow”

The current heart rhythm is healthy

Set the heart rhythm to an unhealthy heart
rhythm

All others

See “Calibration Wizard” section inside User’s
Manual

Artificial ventilations are not
properly detected or not
detected at all

Is the communication indicator panel
consistently yellow?

See solution above in section making
reference to “blinking communication indicator
is consistently yellow”

Ventilations are only detected when
the respiratory rate is set to O per
minute (0 / min).

Set respiration rate to zero

All others

See “Calibration Wizard” section inside User’s
Manual

Simulator’s chest does not
rise with artificial ventilation
(e.g. BVM)

Simulator not running

In some simulators, the trachea is
disconnected from the lungs when they are not
on.

Disable lung/s

Enable the lungs from “Status/Detail” pnel on
the GaumardUI software

Punched cricothyrotomy tape

Make sure that the tape covering the
cricothyrotomy site is completely sealed

Low chest rise (or no chest
rise at all) while breathing

Wrong settings or disabled lungs

Make sure lungs are enabled and both
respiration rate and inspiration percent are
different from “0”. Try changing the respiration
rate to a different value, and if still nothing
happens, try turning the simulator off and
restarting everything to make sure the internal
air compressor gets its initial settings

Low air volume

(SUSIE® only)

Set Respiration Rate to 13, and Inspiratory
Time to 33%. Allow it to run at least 5 minutes
and then using a small screwdriver, turn slowly
clockwise a black screw located in SUSIE®'s
lower back until desired chest rise
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Symptom

Possible Cause

Solution

Loss of brachial pulse

Brachial pulses disabled

Make sure to enable brachial pulse on
“Status/Details” panel

Pre-built scenarios don’t
show up

Select “Quick Start Scenarios” when starting
the software.

Should user forget to do so, there’s no need to
shut down the software and open it again in
order to load the pre-built scenarios. Go to
“File/Profile” menu and then select “Modeled
Scenarios”

A sound is absent or is not
heard at desired volume
level

Volume not set to user’s criterion.

Every sound has a volume control. Play with
the volume control to get it to the desired level.

Cyanosis intensity is too
much or too little

Cyanosis intensity not set to user’s
criterion.

Set Cyanosis level to a desired level by playing
with the “Set Max cyanosis level” control.

Pulse oximeter feature is
not functioning correctly (if
Oxygen Saturation feature
is factory installed)

Using a different oximeter / sensor
for which the simulator was
calibrated

The simulator must be calibrated with the
oximeter instrument that is going to be used
(including the Pulse Oximeter Sensor).
Oximeter sensors cannot be swapped even
with oximeters of the same brand and model.

An oximeter that includes carbon monoxide
and/or methemoglobin sensing is being used.
These will not work with SUSIE.

Oximeter has been placed on the Drug
Recognition arm. This arm does not have the
Oxygen Saturation feature.

Pulse Oximeter Sensor not properly
placed

Make sure to slide the pulse oximeter probe all
the way into the simulator’s finger. Ensure the
emitter part (the red light) of the probe is on
the nail side of the finger.

If it is believed that the probe is properly
placed, it means that it was not properly placed
when calibration was performed and re-
calibration is necessary. See O,Sat calibration
section for more info.

Offset value within + 2

A +2 discrepancy between value set and
oximeter reading for O,Sat values above 80%,
and +3 below 80%, should be expected.

Incorrect readings after calibration

While calibrating, wait 5-10 seconds for values
to stabilize on the oximeter. Then click next to
calibrate the next value.

If simulator is equipped with bilateral O,Sat
arms, select the left arm from the calibration
menu and place the oximeter on the left finger.

Drug ID is not being read

Syringe has not been programmed

Program syringe as per manual’s instructions

User Guide | SUSIE S2000 | 65



Symptom

Possible Cause

Solution

Syringe is not in the field of the RFID
reader

This could happen when injecting the cephalic
vein close to the hand and having the syringe
sideways to the plane of the forearm.

Drug amount registered is
not correct

Wrong calibration

Calibrate the drug arm as per calibration
instructions

Injecting too fast

Maximum injection rate is 9999 ml/hr. This rate
won'’t be exceeded when injecting into the
veins using a 22 g needle.

Not reading the syringe ID

If RFID tag on syringe is not read, the system
tends to read fewer amounts than actually
injected. This could happen when infusing the
drug thru the side port on the arm. When doing
so, place a tagged syringe on the syringe holder.
See troubleshooting section “Drug ID is not being
read” too.

Fluid reservoir is full

The maximum amount of fluid injected properly
read before purging the internal reservoir is 50 cc.
Make sure to purge the reservoir or permanently
connect a purging line (see instructions)
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Wireless Network

UNI generates the vital signs information
displayed on the virtual monitor PC. The
information is transmitted through a wireless
ad-hoc connection between the two
computers in real time.

The wireless settings are configured at the
factory, so no additional configuration is
required.

Use the “Create an ad-hoc Wireless
network” tool to configure the wireless ad-
hoc link between the two computers. Then,
configure the connection between UNI and
the Gaumard Monitors software.

UNI NETWORK CONFIGURATION

Complete the next steps using the
“Controller - Create Ad-Hoc Wireless
Network” tool built in to UNI software.

1. From the menu bar, go to Help >
“Create ad-hoc Wireless Network”

The “Controller - Create Ad-hoc
Wireless Network” window is displayed

2. Select the “Wireless Network Adapter”.
If the wireless adapter is not listed, first
enable the adapter using the Windows®
network menu and then return to this
window.

Clear previous network settings:
Create Ad-Hoc Wireless Network

1. Select Wireless Network Adapter E

2. Wireless Network Name @
\GaumardNet |

Apply Wireless Network Settings

Set Wireless Network Dynamic

Set Dynamic IP

3. Enter a wireless network name (case
sensitive). Use the same wireless
network name to configure the Gaumard
Monitors PC. “GaumardNet” is the
required name for Windows® 7
computers.

2. Wireless Network Name E]

GaumardNet

Apply Wireless Network Settings

4. Click “Set Dynamic IP".to set the
wireless network dynamic.

Set Wireless Network Dynamic

5. Click “Apply Wireless Network Settings
to save the settings.

Set Wireless Network Dynamic

6. Restart the computer.

Clear previous network settings:
Create Ad-Hoc Wireless Network

1. Select Wireless Network Adapter E

2. Wireless Network Name @
|GaumardNet

» Apply Wireless Network Settings F

Apply the new network settings and create the ad-hoc wireless network.

Set Dynamic IP

GAUMARD MONITORS NETWORK
CONFIGURATION

After the UNI control computer is configured,
complete the next steps using the “Create an
ad-hoc network tool” included in Gaumard
Monitors software.

1. On the virtual monitor computer,
click the Gaumard Monitors icon to
start the vital signs software.

2. Click the V menu near the top left
corner and select “Create Ad-Hoc
Network”.
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Monitor Selection...

| dm |

Keyboard
Toggle Cursor

Remote Access Via Network
Check for Updates

The “Virtual Monitor - Create ad-hoc
Wireless Network” window is displayed.

3. Select “Wireless Network Adapter”. If
the wireless adapter is not listed, first
enable the adapter using the Windows®
network menu and then return to this
window.

Clear previous network settings:  Clear

1. Select Wireless Network Adapter | ?

2. Wireless Network Name | ?

‘GaumardNet ‘

Apply Wireless Network Settings

k;-‘,’g [ Wireless Network Dynam _

Set Dynamic IP

4. Enter a wireless network name (case
sensitive). Use the same name entered
in the controller computer.
“GaumardNet” is the required name for
Windows® 7 computers.

2. Wireless Network Name | 2

éGaumardNet |

Apply Wireless Network Settings
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5. Click “Set Dynamic IP”.to set the
wireless network dynamic.

| Set Wireless Network Dynami 'H

6. Click “Apply Wireless Network Settings”
to save the settings.

GaumardNet |

A] Apply the new network settings and create the ad-hoc wireless netw:

S T SIS T TTINT

7. Restart the computer.

CONFIGURE THE VITAL SIGNS
BROADCAST

After the wireless ad-hoc link is established
between both computers, complete next
steps to configure the transmission of the
vital signs information.

1. Verify that both computers are
connected to the GaumardNet
network using Windows® wireless
connection menu. If the computers
are not connected, select the
“GaumardNet” network and click
“Connect” manually.

-
Currently connected to:
_.:. Identifying... (GaumardMet)
@ MNolnternet access
|

Wireless Network Connection 2 ~
GaumardNet Connected :"._
simcenter M
Gaumard GuestMet 1.!_'
| 2WIRELS9 i
Santex i
Other Metwork A

Open Metwork and Sharing Center

2. Start the UNI control software.

3.  On the UNI menu bar, click
Monitors> Configuration.



The “HAL Virtual Monitor Setup” window
is displayed on the UNI menu bar, click

Monitors> Configuration.

The “HAL Virtual Monitor Setup” window

is displayed.

(¢ Virtual Monitor Setup

Configure and broadcast the simulator’s vital signs over a wireless network.

Select the number of Gaumard Monitor computers that display this
simulator’s vital signs. Also, enter a name and description for each
monitor connection instance.

[”] All sensors always ON

Network Status:  connected Network Name:  GaumardNet
Controller Name: GMRDO03-PC 1P Type: automatic
Adapter: ‘Wire\ess Network Connection 2 * | <refresh ” ? ‘
por [sao || <t | 7
‘ Connect
Connected to:

4. Set the adapter to “Wireless
network connection”

5. Verify the network status and
network name, then click “Connect”
to begin transmitting the vital signs
information.

6. Write down the “Controller Name”
and “Port number”.

7. Start the Gaumard Monitors
software on the virtual monitor PC.

8. Click the “V” menu near the top left
corner, and then select “Comm
Setup”.

The “TCP Comm Setup” window is
displayed.

Wireless Communication Setup

If the communication has not been established, please enter the name or IP
address and port number selected on the controling computer.

Noelle
Network Status:  Connected _
Network Name:

IP Type: Automatic

Port: 8001 [
Controller Name: |GMRD003-P( |

9. Click “Connect” to accept the
incoming connection.

Wireless Communication Setup
If the communication has not been established, please enter the name or IP
address and port number selected on the controling computer.

Noelle

Network Status:  Connected -
Network Name:

1P Type: Automatic

Port; |8001 |
Controller Name: |GMRDO03-PC ‘

|| Show 1P

To connect both computers using a local
internet network, follow the steps below:

1. Verify that both computers have
applied “Set Wireless Network

Dynamic”. Refer to UNI and
Gaumard Monitors network
configuration sections for
instructions.

2. Disconnect both computers to the
GaumardNet network and connect
them to the local network manually
using Windows® wireless
connection menu.

3. Repeat the same steps listed above
to connect the UNI software to the
Gaumard Monitors software.

Currently connected to: *

gaumard.com
Internet access

Wireless Network Connection 2 A
simcenter Connected ﬂ!ﬂ
Gaumardhet a
Gaumard GuestMet ﬂ!!]
Cther Metwork ,ﬂﬂ

4. Repeat the same steps listed above
to connect the UNI software to the
Gaumard Monitors software.

¢ Virtual Monitor Setup

Configure and broadcast the simulator’s vital signs over a wireless network.
Select the number of Gaumard Monitor computers that display this

simulator’s vital signs. Also, enter a name and description for each
monitor connection instance.

[”] All sensors always ON

Network Status:  connected Network Name:  simcenter
Controller Name: GMRDO03-PC IP Type: automatic
Adapter: ‘\-‘.‘IVE‘ESS Network Connection 2
por
‘ Stop
Connected to:  Gaumard_Trainin 192.168.55.128
Wireless Communication Setup Ea

If the communication has not been estabiished, please enter the name or IP
address and port number selected on the controling computer.
Noelle
Network Status:  Connected _
Network Name:
P Type: Automatic Port: 1;1001 \ [z |
Controller Name: [GMRDO03-PC o ]

[_] Show 1P
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Spare Parts List

Contact Gaumard Scientific for a complete list of consumables and replacement parts and their prices

Item ID Name Type Description
S2000.001 A/C Virtual Monitor R A/C Powered 17" Touch Screen monitor
S2000.002 D/C Virtual Monitor R D/C Powered 12" Touch Screen Mobile Monitor with stylus
S2000.009 Power Package R 100-240 V AC battery charger with rechargeable battery
S2000.010 Battery C Rechargeable battery
S2000.011 Battery Charger R 100-240 V AC battery charger with label
S2000.024L.L Lower Left Arm C Arm with Osat index finger and bleeding middle finger, light color
S2000.024L.R2.L Lower Left Arm C Osat index finger, bleeding middle finger and microphone, light
Revision 2
S2000.024R.L Lower Right Arm C Lower right IV arm with Osat index finger
S2000.024R.R2.L | Lower Right Arm C Lower right IV arm with Osat index finger and microphone
Revision 2
S2000.027L.L Lower Left Leg R Lower leg assembly, includes pedal and popliteal pulse sites
S2000.027R.L Lower Right Leg R Lower right leg assembly, includes pedal and popliteal pulse sites
S2000.047 Bleeding Finger R Includes 6c¢cc syringe with filling tube
Filling Kit
S2000.048 Adult IV Filling Kit R Fluid dispensing syringe with filling tube for S2000
S2000.054L.L Automatic BP Upper M Light color upper left arm assembly with automatic BP module
LEFT Arm
S2000.054R.L Automatic BP Upper M Light color upper right arm assembly with automatic BP module
RIGHT Arm
S2000.055 Decubitus Ulcers R
S2000.056 GYN Package R 3 normal patent cervices, 4 abnormal cervices, 1 uterine assembly with
shortened round ligaments and Fallopian tubes, 7-9-week pregnant
uterus with Fallopian tubes, 10-12-week pregnant uterus with Fallopian
tubes, 20-week pregnant uterus, 1 talcum powder, 1 small flashlight
S2000.057 Breast Palpation Kit R Set of 7 breasts
S2000.060 Simulator Transport A Soft storage and transport case with wheels
Case
S2000.073.L Active Eyes M Replacement active eyes assembly for light skin simulator
S2000.200 Audio & Video A
Recording System
S2000.204 Tablet PC R Wireless tablet PC with stylus control
S2000.205 Bump Case R Bump case for tablet PC
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Item ID Name Type Description

S2000.206 RF Module R Radio Frequency Module with USB connector

S2000.224L.L Lower Left Arm M Arm with Osat index finger and bleeding middle finger reveining
Reveining

S2000.224L.R2.L Lower Left Arm Rev M Arm with index finger, bleeding middle finger and mic reveining
2 Reveining

S2000.224R.L Lower Right Arm M Lower right IV arm with Osat index finger reveining
Reveining

S2000.224R.R2.L | Lower Right Arm M Lower right IV arm with Osat index finger and microphone reveining
Rev 2 Reveining

S2000.400R.L Automatic Drug A Automatic Drug Recognition light color right arm. Includes physiologic
Recognition System modeling

S2000.400R.U.D Automatic Drug U Automatic Drug Recognition dark color right arm UPGRADE.
Recognition System

S2000.401R.L Automatic Drug R Automatic drug recognition right arm replacement
Recognition Arm

S2000.401R.U.L Automatic Drug U Automatic drug recognition right arm UPGRADE
Recognition Arm

S2000.500 Automatic A
Physiologic control

S2000.EXW Two Year Extended A Extended warranty for Years Two AND Three
Warranty

S2000.INST In-Service Training A Day of in-service training and installation

C=Consumables; R=Replacements; A=Accessories; U=Upgrades; M=Replace in Miami Factory ONLY
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Warranty

EXCLUSIVE ONE-YEAR LIMITED WARRANTY

Gaumard warrants that if the accompanying Gaumard product proves to be defective in material or workmanship
within one year from the date on which the product is shipped from Gaumard to the customer, Gaumard will, at
Gaumard’s option, repair or replace the Gaumard product.

This limited warranty covers all defects in material and workmanship in the Gaumard product, except:
1. Damage resulting from accident, misuse, abuse, neglect, or unintended use of the Gaumard product;

2. Damage resulting from failure to properly maintain the Gaumard product in accordance with Gaumard
product instructions, including failure to property clean the Gaumard product; and

3. Damage resulting from a repair or attempted repair of the Gaumard product by anyone other than Gaumard
or a Gaumard representative.

This one-year limited warranty is the sole and exclusive warranty provided by Gaumard for the
accompanying Gaumard product, and Gaumard hereby explicitly disclaims the implied warranties of
merchantability, satisfactory quality, and fitness for a particular purpose. Except for the limited obligations
specifically set forth in this one-year limited warranty, Gaumard will not be liable for any direct, indirect, special,
incidental, or consequential damages, whether based on contract, tort, or any other legal theory regardless of
whether Gaumard has been advised of the possibilities of such damages. Some jurisdictions do not allow disclaimers
of implied warranties or the exclusion or limitation of consequential damages, so the above disclaimers and
exclusions may not apply and the first purchaser may have other legal rights.

This limited warranty applies only to the first purchaser of the product and is not transferable. Any
subsequent purchasers or users of the product acquire the product “as is” and this limited warranty does not apply.

This limited warranty applies only to the products manufactured and produced by Gaumard. This limited
warranty does not apply to any products provided along with the Gaumard product that are manufactured by third-
parties. For example, third-party products such as computers (desktop, laptop, tablet, or handheld) and monitors
(standard or touch-screen) are not covered by this limited warranty. Gaumard does not provide any warranty, express
or implied, with respect to any third-party products. Defects in third-party products are covered exclusively by the
warranty, if any, provided by the third-party.

Any waiver or amendment of this warranty must be in writing and signed by an officer of Gaumard.
In the event of a perceived defect in material or workmanship of the Gaumard product, the first purchaser must:

1. Contact Gaumard and request authorization to return the Gaumard product. Do NOT return the Gaumard
product to Gaumard without prior authorization.

2. Upon receiving authorization from Gaumard, send the Gaumard product along with copies of (1) the original
bill of sale or receipt and (2) this limited warranty document to Gaumard at 14700 SW 136 Street, Miami, FL,
33196-5691 USA.

3. If the necessary repairs to the Gaumard product are covered by this limited warranty, then the first
purchaser will pay only the incidental expenses associated with the repair, including any shipping, handling,
and related costs for sending the product to Gaumard and for sending the product back to the first
purchaser. However, if the repairs are not covered by this limited warranty, then the first purchaser will be
liable for all repair costs in addition to costs of shipping and handling.

EXTENDED WARRANTY

In addition to the standard one year of coverage, the following support plans are available:
e Two-Year Extension (covers second and third years)

Call for pricing (USA only)
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Contact Us

On the web
www.Gaumard.com

Technical Support
support@gaumard.com

Sales and Customer Service
sales@gaumard.com

Phone:

Toll-free in the USA: (800) 882-6655
Worldwide: 01 (305) 971-3790

Fax: (305) 667-6085

Before contacting Tech Support you must:

1. Have the simulator’s Serial Number
(located in the left leg under the IM site)

2. Be next to the simulator if
troubleshooting is needed

Gaumard Scientific
14700 SW 136 Street
Miami, FL 33196-5691 USA

Office hours: Monday-Friday, 8:30 am
- 4:30 pm EST (GMT-5, -4 Summer
Time)

Always dispose of this product and its
components in compliance with local laws
and regulations.

(&

Gaumard®, SUSIE ®, UNI™ are trademarks
of Gaumard Scientific Company, Inc.

© Gaumard Scientific Company, 2014. Made
in U.S.A. All rights reserved.
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